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This guide provides information about the various concepts and processes for the Service Scheduler
Workbench.

Objectives
This document is designed to meet the objectives described below. It is assumed that you already have
a understanding of Infor LN Service

Understand the following concepts
 ▪ Assigned Activities Section -GANTT

▪ User Settings Section
▪ Activities Section
▪ Location Section
▪ Assigning an activity to an Engineer
▪ Multi-activity Planning
▪ ERP settings for Workbench

Document summary
This guide explains the various concepts and processes available in the Service Scheduler Workbench.

How to read this document
This document is assembled from online Help topics. As a result, references to other sections in the
manual are presented as shown in the following example:

For details, refer to Infor LN Service Online Help.

Please refer to the Table of Contents to locate the referred section.

Underlined terms indicate a link to a glossary definition. If you view this document online and you click
on underlined text, you jump to the glossary definition at the end of this document.

Comments?
We continually review and improve our documentation. Any remarks/requests for information concerning
this document or topic are appreciated. Please e-mail your comments to documentation@infor.com .

In your e-mail, refer to the document number and title. More specific information will enable us to process
feedback efficiently.

Contacting Infor
If you have questions about Infor products, go to the Infor Xtreme Support portal.

If we update this document after the product release, we will post the new version on this website. We
recommend that you check this website periodically for updated documentation.
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If you have comments about Infor documentation, contact documentation@infor.com .
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This chapter provides a brief introduction of the Service Workbench.

Service Scheduler Workbench
The Infor LN Service Scheduler Workbench is used for planning and scheduling of Service Order and
Work Order activities. You can use the workbench to improve efficiency and provide high visibility of the
Field Service and Work Order activities.

The activities can be scheduled and released based on the conditions such as skills, availability, and
locations.

The Service Scheduler workbench is positioned with Service Planning. The Service Planning functionality
includes:
 ▪ Territory Planning

▪ Preventive Maintenance Planning
▪ Group Planning

The Service Scheduler Workbench is used to link the plans generated by the Group Planning functionality.

You can generate a pre-plan using the Group Planning functionality. After the group plan is transferred
for execution, the details and exceptions are planned and scheduled using the Service Scheduler
Workbench.

Planning Modes
Primarily, there are two planning modes in the Service Scheduler Workbench.
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Employee Based Planning
This type of planning is used to assign the service order activities, work order activities, and planned
activities to engineers. The activities can be assigned/unassigned/reassigned to engineers based on
these planning methods:

Plan based on the availability of the engineer

This planning method depends on the availability of the engineer to visit the customer. You must select
an activity and using the drag-and-drop feature, to add the activity to the Gantt chart. The workbench
calculates the new planned start and finish time. However, the time may deviate from the requested
time of the activity.

Plan based on the requested time of the activity

This plan is based on the availability of the engineer to perform the activity, based on the requested
planned start and finish time. When you select an unassigned activity, a list of skilled engineers available
to perform the activity, is displayed. Using the drag-and-drop feature link the activity to the required
engineer. This process is executed to ensure that the planned start and finish time is not modified.

Plan based on a geographical selection

This plan is used to group the activities in a specific region, to reduce the travel time. Using the map,
you must select the activities for a required region. In the grid, you must select the unassigned activities
for the region, and using the drag-and-drop option, add the activities to the Gantt chart. Optionally, the
activities can be sequentially planned simultaneously.

Installation Group Based Planning
Using this planning method, you can plan the service order activities and planned activities, based on
the Installation group or serialized items. In this view, you can effectively perform preventive maintenance
by the Installation group or serial and accordingly plan the service activities for the group.

Layout
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This chapter provides a brief description of the concepts available in Assigned Activities Section-GANTT.

Assigned Activities Section - GANTT
This Assigned Activities section displays a graphical view of the service activities based on the planned
start and finish time of the assignment. The user can view all the engineers in the left panel and the
order activities assigned to the engineers in the right panel. The employee’s availability and
non-availability, based on the calendar data, is also displayed. The first and second row of the Gantt
chart display the activity constraints of a selected activity, including the planned Start/Finish Time, Earliest
Start/Latest Finish Time, the calendar assigned to the Installation Group, and so on.

Assigned Activities Section: Other Features
These are the additional features supported by the Service Scheduler.

Engineer Section

A list of engineers for each selected department is displayed on the Gantt chart. The Engineer widget
displays this information:

Selection: If this checkbox selected, the employee’s location is highlighted on the map.

Picture: Displays the photograph of the employee. This is an optional feature and can be set using the
Show Picture option in the Gantt tab in the User Settings section.

See Appendix: Adding Employee Picture.

Refresh Location: Retrieves the latest location of the engineer from the application and refreshes the
location data on the map.
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Activity Constraints

You can use this feature to check if the earliest start time, latest finish time, the calendar assigned to
the Installation Group, planned start time, planned finish time, and ATP are synchronized or if there is
a deviation. This is depicted in the first two rows titled, Planned Timeline and Earlier Start-Latest Finish
Timeline, in the Gantt chart.

Use the Show Activity Constraints option in the User Settings section to enable or disable this option.

When an activity is selected, the first two rows in the Gantt chart display an activity bar for each row.
The activity bar in the Planned Timeline represents the planned start time and planned finish time of the
activity. The activity bar in the Earlier Start-Latest Finish Timeline represents the earliest start time and
latest finish time of the activity. An indicator is also displayed for the ATP date. The Installation Group
Calendar information is highlighted in the second row. If there is conflict for the activity, an indicator is
displayed on the activity bar. To view the reason for the conflict hover over the indicator.

You can select the colors for the activity bars on the Planned Timeline and Earlier Start-Latest Finish
Timeline, using the ATP indicator option in the User settings section, on the Colors tab.

Zoom in and Zoom out

You can use the Zoom option (CTRL + Scroll Wheel) for a Gantt Time scale.

Double-click the time interval to zoom in on the chart.

If a particular activity must always be displayed in the visible region, point on that activity and select
CTRL + Scroll Wheel.

Assignment Update

Use this option to plan for each assignment individually. For example, there are 3 assignment lines for
an activity. You can schedule these 3 assignments with the durations 2 hours, 2 hours, and 1 hour
respectively.When the plan is saved, the planned start and planned finish times of all the three
assignments are updated in Infor LN. However, the activity duration, activity planned start, and activity
planned finish times are not modified.
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Activity Update

Use this option to plan for all assignments for an activity at a given time. For example, the activity’s
duration is of 5 hours and the activity has 3 assignment lines. You can schedule the 3 assignments with
the duration of 7 hours. When the plan is saved, the planned start and planned finish times of all the
three assignments are updated to the application. Also the new vales are applied to the activity duration,
activity planned start, and activity planned finish times in the application.

After an activity update is completed and the user changes to an assignment update or vice versa, all
the changes are saved, even if the Auto Save check box is not selected in the User Settings section.

Various views in a Gantt chart

You can select various options to display the data using these filters:
 ▪ Selected Activity’s Context: All engineers assigned to the selected activity are displayed in

the left panel of the Gantt chart. Only the selected activity and the related assignments are
displayed in the right panel. Features such as Unassign, Cut, and Copy are disabled in this
view.

▪ Selected Order’s Context: All engineers assigned to all activities for the selected order are
displayed in the left panel of the Gantt chart. Only the selected order and the related activities
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and assignments are displayed in the panel section. Features such as Unassign, Cut, and
Copy are disabled in this view.

▪ Show All Overlapped Activities: All the overlapped activities in the selected time frame (for a
day, week, or month) are displayed on the Gantt chart. To exit from this view, select the Show
All option.

▪ Show All: By default, this view is displayed. In this view, all the service engineers are
displayed.When the data is updated (refresh) or an unassigned activity from the grid is selected,
the view changes to the default view.

▪ WHT (Working Hour Type) View: When you select the display color for the Working Hour
types in the User settings, the Working Hour Type View icon is enabled. Click the Working
hour icon. All the engineers available for the configured working hour types are filtered and
displayed. This option helps in planning the weekend duties, new product duties and so on.

Activity bar context menu options

Right-click the activity bar, on the Gantt chart, to open a context menu with these options:
 ▪ UnAssign

Use this option to unassign an assigned activity. You can also unassign multiple activities.
After the assignment(s) for an activity are unassigned, the assignment(s) are either removed
or converted to unassigned activities, only if the activity belongs to the selected department.

▪ Cut, Copy, and Paste
When you add an activity to the Gantt chart using the Cut and Paste option, the activity’s
planned start time is considered as the scheduled start time. If the Cut and Paste (Respect
drop time) option is selected, the time defined for the activity is used. The same is applicable
for the activity’s planned start time for the assignment.
See Multi Activity Planning for Assigned Activities section.

▪ Drill back options
These are the available options:

▪ Service Order: Drill to Service Order, Drill to Service order lines, Drill to Service order
activity lines, and Drill to Service order activity details.

▪ Work Order: Drill to Work Order, Drill to Work order lines, Drill to Work order activity lines,
and Drill to Work order activity details.
Drill to Service engineers, and Drill to Appointment options are also available. All these
options enable you to access the Infor LN sessions. For the drill back sessions such as
order details, order lines, Activity details, and Activity lines, if the data in Infor LN is modified
the changes are updated to the workbench.

▪ Foreman Assignment
A foreman is a service employee, to whom several service employees report. If you select an
unassigned activity, using the drag-and-drop feature, and assign the same to a foreman, the
Foreman Assignment option is enabled. -If this option is selected, additional assignments for
each of the service employees assigned to the foreman are created.
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After the Assign action is complete, the view mode changes to the Selected Activity’s Context
and the newly created assignments are displayed on the Gantt chart in a single screen The
Foreman Assignment option can also be enabled using the Copy/Paste option.

▪ Show Route
When you select multiple activities of the same engineer, the Show Route option is enabled.
This option draws a route on the map starting with the first activity in the sequence till the last
activity. The GPS co-ordinates of the activity’s location address are considered for drawing
the route. The route is based on the Assignment Plan Start Time.

▪ Release
A Free or Planned activity can be set to status ‘released’ using the Release option.

Gantt Context Menu options

Right-click a blank area on the Gantt chart, the context menu with these options is displayed:
 ▪ Create or Change Working Hour

Use this option to change the status of the working hours of an engineer to Available or
Unavailable.

▪ Create Service Order
You can generate a service order from the workbench using the Create Service Order option.
An Infor LN session is started from the workbench; wherein the planned date is transferred
from the workbench. You must create a new activity. By default, the current engineer is assigned
to an activity. To view the new order on the Gantt chart click Save and Exit (Ctrl + L) in the
Infor LN session.

▪ Create Work Order
You can insert a work order from the workbench using the Create Work Order option. An Infor
LN session is started from the workbench; wherein the planned date is transferred from the
workbench. You must create a new activity. By default, the current engineer is assigned to an
activity. To view the new order on the Gantt chart, click Save and Exit (Ctrl + L) in the Infor
LN session.

▪ Drill back sessions
Drill back sessions such as Drill to Employee details, Drill to Skills by Employee, Drill to Hours
accounting, Drill to General hours accounting, and Drill are used to access the Infor LN calendar
and enable you to access the Infor LN sessions from the Workbench.
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This chapter provides a brief description of the Activities Section.

Activities Section
The unassigned and assigned activities are displayed in the grid view. The user can view the service
activities with the status Free, Planned, and Released.

Planned activities are displayed on the Planned Activities tab.

You can assign planned or unassigned activities to the required employee using the Gantt chart and
the drag-and-drop option.

Activities Section
The Activities grid displays the assigned, unassigned activities for the given time horizon as supplied
by you on the toolbar. Use the filters available for each column, to filter the data and view a limited set
of selection.

Planned Activities

Planned activities are used to list the activities planned for a serialized item or Installation Group and
improves the long term preventive maintenance process.

When a planned activity is selected, the required skills are populated in the Skill combo section and the
engineers with matching skills are displayed on the Gantt chart.

To transfer a planned activity to a service order, drag the selected planned activity to the Gantt area of
a corresponding engineer and for the required time.

Other Features

The other features available are:
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Grid Filter
This option is provided for each column in the grid. Using these filters you can filter the data by selecting
and clearing the data available in the columns.

Saving Filters
The planner can add a combination of column filters and save the same to the User Settings. For
example, if a planner regularly filters data based on the Service Type, ‘001’ and the Activity status ‘Free’
and ‘Released’, these steps are required:
 1. Apply the required column filters on the grid.

2. In the ‘Filters’ list on the grid toolbar, select Add.
3. A dialog box is displayed with a list of selected filter columns and the respective values. Specify

a filter name and select Add. Saved filters are displayed as menus in the Filters list.

To apply the filter, click the required filter name and the filter is applied to the respective columns of the
grid. The selected filter can also be saved to user settings along with the ‘Save Settings’ option. This
ensures that the next time the workbench is started, the last selected filter is applied to the grid.

The options for managing filters:
 ▪ Add: A new filter with the specified name is added.

▪ Update: The current filter is updated with the latest changes.
▪ Remove: The current filter is deleted.

This functionality is available in the grids for Employee Based Planning and also for Installation group,
Serial based planning or both.

When the filters are applied on the grid, a filter icon appears on the ‘Filters’ dropdown on the grid toolbar,
indicating that the grid is displaying a filtered set.

Special Filter for Service Engineer and Assignment line Column
When using the filter for the Service Engineer or Assignment Line column, by default, unassigned records
are filtered in.
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Apply Filter To Gantt
Use the Apply Filter To Gantt option to apply the data from the grid to the Map and Gantt section of the
workbench, and enable you to improve the planning with the limited or filtered data.

Clear Filter
Use this option to clear all the filters applied on the grid. In case, the filter is also applied to the Gantt
and map, then this option reset data in all the views to its default state.

Sort by Selected Activities
Use this option to group selected activities.

Skills
Use the Skills option to list the required skills for the selected activity in the grid. Mandatory skills are
displayed with a Red asterisk (*).

Select Order Activities
Use this option to select all the activities that belong to the selected order.

Select Activity Assignments
Use this option to select all the assignments that belong to the selected order-activity.

State Indicators
State Indicators help to easily identify the edit state of activities in the grid, based on different criteria:
 1. An activity is modified, indicated by an orange diamond icon.

2. A new assignment line is added using the Copy/Paste or Drag-and-drop option from the
unassigned list to the Gantt chart. Indicated by a blue star icon.

The activities are displayed with indicators:
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This chapter provides a brief description of the Location Section.

Location Section
This section provides a map view of the engineers and activities (assigned/unassigned/planned), which
helps in easily identifying the location of the engineer and the activity.

You can filter the data to be displayed using the Items To Show list option. The image displays the filter
applied on the engineer and the service order. Similarly, you can filter the assigned activities, unassigned
activities, and the engineer’s locations that must be displayed on the map.

Infor LN Service | User Guide for Service Scheduler Workbench | 19

4
Chapter 4
Location Section



Icons

DescriptionIcon 

Activity pushpin: Represents the assigned and
unassigned service activities. User can hover over
the pushpin to view the tooltip.

Work Order Pushpin: Represents the assigned
and unassigned work order activities. User can
hover over the pushpin to view the tooltip.

Engineer Pushpin: Represents the location of the
engineer.

Planned Activity Pushpin: Represents the planned
activities. User can hover over the pushpin to view
the tooltip.

Location Section – Other Features
The Map/Location section displays the pushpins to represent the engineer, assigned service activity/work
order, unassigned service activity/work order, and planned activity.

Pushpin Selections and Zoom

 ▪ To remove all selections, click on a blank area of the map.

▪ Press Shift + Click to select multiple activities.
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▪ When you zoom to a particular location, only the activities available for the location are
displayed.

▪ To select a region or group of activities, you can also press CTRL and drag the pointer to
create a box over the required region or activity.

▪ To zoom to a particular region or activity’s location, press SHIFT and drag the pointer to create
a box over the required area.

▪ Activities are displayed as pushpins on the map. You can define the size of the pushpins.

▪ For a group of activities with the same location address or the same area or when you zoom
out of an area or a location, a single pushpin represents the region. The pushpin displays the
number of activities. For example, for Germany, a group of 7 unassigned and 9 assigned
activities are displayed. The first part of the pushpin displays the unassigned activities and
the second part displays the assigned activities. You can define the colors for the pushpin in
the User Settings > Map Pushpin section on the Colors tab.

▪ Use the Enable Zoom option to zoom in on the activity address.When this option is cleared,
the map remains at the level already selected by you and you cannot zoom in further.

▪ Use the Zoom to Fit option to zoom in and view all the selected activities and engineers.

▪ Use the Show Convex Hull option to indicate the current work area of the engineer.

Find Closest Engineer

Use this option to locate the engineer closest to the selected activities. This option is used to calculate
the distance and time that the engineer takes to travel to the location address of the activity.

To enable the Closest Engineer option:
 ▪ Multiple engineers and a single activity must be selected. Use the SHIFT + Click option or

press CTRL and drag to create a box over the activities and engineers, and view the required
details.

▪ The estimated time and distance is populated and an Assign option is displayed. To assign
the engineer, select the Assign option. The activity is displayed on the Gantt chart. The route
to each of the selected activities is displayed in Blue.
Note: Work order selection is not supported by the Find the closest engineer functionality

Show Convex Hull

Using this functionality, you can view the activities of the engineer, spread across a geographical area.

To view the Convex Hull:
 1. Select the Engineer(s) (in the Gantt section or on the Map).

2. On the map tool bar, select the Convex Hull check box. The highlighted geographical area
displays the location of the activities for the selected engineer(s) in the Gantt’s time range.

3. When you move the Gantt scale, the convex hull realigns the current activities on the Gantt
(for each of the current scale) chart.
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This chapter provides a brief description of Assigning an activity to an Engineer.

Assigning an activity to an Engineer
Single Unassigned Activity

When a single unassigned activity is selected, these actions are executed:
 ▪ The Gantt chart displays the planned times for the selected activity. Select the ON Freeze

Gantt Scale option to disable this action.

▪ The first and second rows display the activity constraints for the selected activity. The first row
displays the activity planned start/finish time for the task. The second row displays the earliest
start and latest finish time for the task. The calendar assigned to the Installation Group is also
displayed in the background.

▪ The Skills list is populated with the mandatory and optional skills required to execute the
selected activity. Mandatory skills are displayed marked with Red asterisk (*).

▪ The list of engineers with the skills required for the activity, is populated in the Gantt chart.

▪ The Show Available Resources option enable you to see the list of engineers available to
execute the activity during the planned time.

The workbench planning is based on the calendar information. However, in some cases, planning can
be done without the calendar. Use the Ignore Calendar option to ignore the calendar and assign the
task during the engineer’s non-availability time.

Assigning an activity to an engineer:
 1. Plan based on the availability of the engineer: Check when the engineer can visit the customer.

Drag the selected unassigned activity from the grid to the Gantt chart and assign the activity
to the required engineer. The activity’s planned start and finish time are modified.

2. Plan based on the requested time for the activity: Check if an engineer is available for the
requested date/time. Select the engineer(s) from the Gantt and link to the selected activity’s
order number or activity number of the activity, using the drag-and-drop option. The order
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number and the related unassigned activities for the order are assigned to the engineer. Note:
You can also select multiple engineers, if the activity must be shared.

Smart Planning using the drag option
When you select (drag-and-drop option) an activity wherein the finish time of the existing activity is
almost reached, the time difference between the existing activity’s assignment finish time and the selected
time is less than or equal to five minutes, the activity is automatically sequenced. This feature helps you
plan activities without any delay.

Multiple Unassigned Activities

A plan based on the requested time for the activity. You must check if an engineer is available for the
requested date/time.
 ▪ You can select multiple unassigned activities from the Activities section and link the activities,

using the drag option, to the required engineer on Gantt.

▪ You can select multiple unassigned activities from the Activities section and link the activities,
using the drag option, to the required engineer based on the Activity number or the Order
number.

Multiple Unassigned Activities
A plan based on the requested time for the activity. You must check if an engineer is available for the
requested date/time.
 ▪ You can select multiple unassigned activities from the Activities section and link the activities,

using the drag-and-drop option, to the required engineer on the Gantt chart.

▪ You can select multiple unassigned activities from the Activities section. Then select the
required engineer(s) on the Gantt. Now, drag-and-drop the engineers on the activity number
or the order number in the Activities grid.
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This chapter provides a brief description of the Multi-activity Planning.

Multi-activity Planning
Multi-activity Planning enables you to define Time based and Route based planning methods.

Time Based Sequential
This plan enables you to schedule multiple activities sequentially. You can choose either the Forward
Planning or the Backward Planning option.
 ▪ Forward Planning:

On the Gantt chart, select the required multiple activities and using the drag-and-drop option,
link the first activity to the required time. Based on the first activity’s planned start time, all the
other activities are planned sequentially. You can also modify the planned start time of the
first activity, which ensures that all other activities are planned sequentially.
Note: An activity, other than the first activity cannot be selected.

▪ Backward Planning
On the Gantt chart, select the required multiple activities and using the drag-and-drop option,
link the first activity to the required time. Based on the last activity’s planned finish time, all
the other activities are planned sequentially. You can also change the planned finish time of
the last activity using the drag-and-drop option. There by ensuring that, from the last activity,
all other activities are also planned sequentially. An activity, other than the first activity cannot
be selected.

Route Based
The Route based method helps you to schedule a group of activities based on the route. The route is
created based on the locations of the activities for the group. Travel distance and time are calculated
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for the activities. Distances are calculated based on the GPS co-ordinates specified for the address.
The travel time is combined with the duration of the various activities to be executed at the location.

Note

You can also select a work order activity with the service order activity, when performing multi planning.

You can maintain the default information required for the multi-activity planning in the Multi Activity
Planning section, on the User Setting tab. You can also define the Planning Method, Distance Calculation
Method, Route Start Address, Average Travel Speed, Travel Offset Time, and so on.

Note

Route Based Planning Method is applicable from Infor LN FP8 onwards.

The planning process is executed based on the value of the Planning Method specified in the User
Settings.

The Route Based method fields:
 ▪ Distance Calculation Method

This method is used to calculate the distance between two locations.

▪ As The Crow Flies: Distance is calculated using a simple formula.

▪ Bing Maps: Uses a dedicated web service. An internet connection is required wherein
Infor LN requests the Bing maps web service to calculate the distance.

▪ Route Start Address
▪ First Activity: Start the route at the first activity. This is the default value.

▪ Company: Start the route at the company address.

▪ Service Department: Start the route at the service department address.

▪ Service Engineer: Start the route at the service engineer address.

▪ Keep Sequence Of Activity Set
If you select this check box, the application does not change the sequence of the activities
when planning for the specified group. A route is defined from the first activity, to the last
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activity. The order of the activities is not changed. Only the distance and the travel time between
the locations of the service orders, are calculated.
When you select this check box and select the Multi-activity Planning option, the Activity
Sequence grid with the list of activities, selected by the user, is enabled. Use the Up and Down
arrows to change the sequence of activities. After the sequence is set, click Generate Group
Plan.
When this check box is cleared, the shortest route between the locations is calculated and
the order of the activities is updated.

▪ Respect Earliest Start Time
Select this check box to indicate if the earliest start time of a service order activity must be
considered.

▪ Yes: The service order activity is planned with Planned Start Time set to the Earliest Start
Time.

▪ No: Planned Start Time can be planned before the Earliest Start Time.
Note: The default value is No.

▪ Respect Latest Finish Time
Select this check box to indicate if the latest finish time of a service order activity must be
considered.

▪ Yes: The Planned Finish Time cannot be scheduled after the Latest Finish Time. The
service order activity is not planned and a warning message is displayed.

▪ No: The Planned Finish Time can be scheduled after the Latest Finish Time.
Note: The default value is No.

The Preview option is enabled when you select the Multi-activity Planning option. You can check the
complete route plan. You can also change the Route Start Address, or Average travel speed, or check
the flags (such as Respect Earliest Start Time and so on), before you click Generate Group Plan.

When you click Preview, the entire route is planned and the complete information such as the Start city
of the route, planned travel start and finish times, planned start and finish times, travel duration, travel
distance, and End city of the route, are displayed in the Activity Sequence grid. Information about the
route start and end city are displayed in a dummy row at the start and end of the Activity Sequence grid.
When the Company, or Service Department, or Service engineer for the Route start address is defined,
the route begins at the respective location address and is completed only on reaching the Company, or
Service department, or Service engineer location address. The travel finish time to reach the respective
locations is displayed with the route end city in a dummy row at the end of the grid.

Start time is based on travel distance and time. Planning is based on the start address of the service
engineer.

Indicative route on the map based on the locations and sequence.
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Multi Activity Planning for Unassigned Activities
To use this functionality, you must select the Respect Drop Time option, select the multiple unassigned
activities and link the activities to an Engineer on the Gantt chart, using the drag-and drop option.
Activities are adjusted based on the Planning Method specified in the User Settings.

Multi-activity Planning for Assigned Activities
You can use this planning option for the same engineer or another engineer when the activity is a
Reassignment.

Case 1 - Same Engineer Assignment

For the same engineer, you must select the multiple activities, using the Shift key, on the Gantt chart.
Press the Ctrl key and link the first activity to the required date and time, using the drag-and drop option.

The user selects three activities and links the activities to the required time for the same engineer.

If you set the Planning Method to Time Based Sequential, the activities are arranged in a sequence (as
displayed). However, even if the selected time is 8:15 AM, the calendar time is considered and the
starting time is adjusted to 8:30 AM.

Note

You can also link the selected activity to the required time when using the Forward Planning option (as
displayed). Similarly, you can also link the last selected activity to the required time when using the
Backward Planning option.

You can also right-click and select the Cut and Paste option (Respect Drop Time) to specify the required
time.

Case 2 - Other Engineer Assignment:

To reassign the selected activities to another engineer and to use multi-activity planning, you must select
the Respect Drop Time option and link (using the drag-and-drop option) the selected activities to another
engineer for the required time. Based on the User Settings, the Multi-activity Planning functionality is
used.

You can also right-click and select the Cut and Paste option (Respect Drop Time) to specify the required
time.
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This chapter provides a brief description of the User Settings Section.

User Settings Section
The Service Scheduler Workbench supports the Persistent Docking layout. You can use this feature to
define the grid column width, grid column sequence, docking panes position, in the workbench using
the Save Defaults option on the Workbench tool bar.

General Settings
The settings available on the General tab:
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Views

The Views section allows you to select the views that must be displayed in the workbench and also
select the items (service orders or work orders) with the Status (Free or Planned, etc) to be displayed.

To differentiate between different objects on the Gantt chart, the pattern can also be specified.

Planning Horizon

 ▪ The Type field can be set to Fixed or Relative.

▪ Fixed type retrieves the data from the date as specified in the From field.

▪ Relative type retrieves the data based on the current date.

▪ The Days field can be set to the number of days for which data must be fetched from the Infor
LN.

Update Indicators

You can specify the type of update that must be performed at the Activity level or the Assignment level.

Location

Map Zoom Level: You can select the default map zoom level for the Service Scheduler Workbench.

Activities (Grid)

Using this option, you can choose to display the assigned, or unassigned, or both types of activities in
the Activities section.

Location

Map Zoom Level: You can specify the default zoom level of the map for the Workbench.

Pushpin Size: You can specify the default pushpin size to be displayed on the map.

Enable Zoom: Select this option to enable the zoom in and zoom out on the map.

Distance Calculation Inputs

 ▪ Distance calculation for the closet engineer
This method is used to calculate the distance between two locations.
As The Crow Flies: Distance is calculated using a simple formula
Bing Maps: Uses a dedicated web service. An internet connection is required wherein Infor
LN requests the Bing maps web service to calculate the distance.

▪ Average Travel Speed
Average travel speed to be used for the calculation of the travel time when planning a route.
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▪ Travel Offset Time
Travel offset time to be used for the calculation of the travel time when planning a route.

Others

 ▪ Auto Save
When the Auto Save Option is set to ON, all the actions executed are immediately saved on
the Infor LN backend server. You cannot revert this action.

▪ Auto Refresh
When the Auto Refresh check box is selected, the changes in the application are updated in
the workbench periodically, based on the specified time interval.
Note: The auto refresh feature is enabled only when Auto Save is set to On. This feature is
not available for planned activities.

▪ Exclude Service Engineers
The selected Service engineers are excluded from the workbench.

▪ Exclude Service Order Series
The service orders with the specified order series are excluded from the workbench.

▪ Exclude Work Order Series
The work orders with the specified order series are excluded from the workbench.

▪ Show User Profile Departments
When this option is checked, the Departments menu in the toolbar only displays the service
departments that are linked to the user profile.

▪ Apply Filter to Gantt
Based on this parameter, the filter from the Activity grid is applied to the Gantt chart section.

▪ Show in-context engineers: All the activities belonging to the engineers in the grid are
displayed on the Gantt chart.

▪ Show grid content only: All the activities that are currently visible in the grid, are displayed
on the Gantt chart.

Gantt
The Gantt tab enables you to define the display options for the Gantt chart.

View Options

You can define the Gantt time scale displayed in the Workbench.

These are the options:
 ▪ Today: The Gantt time scale is set to Today. You can also select the Visible units and the

Starting Hour.

▪ Current Week: The Gantt time scale is set to Week. You can also select the Visible units and
the Starting Day for Week options. The Starting Day for Week setting is considered only when
the Current Week is the selected View, the first time the application is launched.
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▪ Current Month: The Gantt time scale is set to Month. If the Current Month is the selected view
option, the time scale is 31 days from the current date.

▪ Current Quarter: The Gantt time scale is set to Current Quarter.

Indicator Symbols

You can define the symbols for the various order flags in this order of priority:
 ▪ Blocked

▪ Emergency
▪ Appointment
▪ Appointment + Emergency

Legends

This option is used to configure the Legends that must be displayed on the Gantt tab.

Others

 ▪ Activity Block Description
The selected option is displayed on the activity bar.

▪ Color Procedure
You can define the colors for the activity bar based on the Color Procedure. For example, if
the Status is selected, the colors defined for the activity status such as Free, Released, and
Planned are displayed.

▪ Show Available Resources
Select this check box, to enable the Show Available Resources option.

▪ Freeze Gantt Scale
Select this check box, to enable the Freeze Gantt Scale option.

▪ Respect Drop Time
Select this check box, to enable the Respect Drop Time option.

▪ Round Drop Time to
Use this setting to define the granularity of related drop in time by either 15 minutes, 30 minutes,
or 1 Hour.

▪ Show Activity Constraints
Use this option to view the first two rows of the Gantt chart. This helps you to determine, if the
earliest start time, latest finish time, Installation Group calendar, planned start time, planned
finish time, and ATP are in sync or if there is a deviation.

▪ Show Engineers with Effective Skills
Effective date of the skill is considered when filtering the engineers based on skills.

▪ Show Picture
Use this option to display the picture of the engineer on the Gantt tab.
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▪ Show Conflict Indicator on Activity Bar
The conflict indicator is displayed on the Planned Timeline. When this option is selected, the
conflict icon is also displayed on the Activity bar.

Employee Sequence

You can group employees or define the sequence such that the selected employees are displayed at
the top of the Gantt chart. Select a row to enable the Up or Down arrows. Use the arrows, to shift the
position of an employee. When you set the sequence, the same is displayed on the Gantt when the
Gantt engineers data is updated due to an action such as the selection of Unassigned activity, changing
of the filter views, or filtering the data based on skills.

Colors
Use the Colors tab to define the colors for these options:

Tooltip
The Tooltip option is configurable. You can use this option to choose the fields that must be displayed
with in the tooltips that are displayed on Map and Gantt.
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Multi-activity Planning
Multi-activity planning enables you to implement the Time based and Route based planning methods.

Installation Group
Settings related to installation group and serials view are listed on this tab. This tab is displayed only if
the Installation Group based planning is enabled in the General tab.

Tooltip

You can configure the details to be displayed on the tooltips in the installation or serial view.

Include Planned Activities

If this option is selected, then the planned activities are also brought along with service activities when
the installation group views are loaded.

Activity Block Description

The selected option is displayed on the activity bar.
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This chapter provides a brief description of Infor LN settings for Service Scheduler Workbench.

Infor LN Settings
These settings must be configured to start the Service Scheduler workbench using the Infor LN:

Configure Service Employee
Configure Service Employee using the Employees Service (tsmdm1140m000) or Employee – Service
(tsmdm1640m000) sessions.

Link Planner login to Service Employee
Configure Service employee (planner) linked to the login code using the Employees (bpmdm0601m000)
session.
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Configure User Profile
Configure the user profile using the Service User Profiles (tsmdm1150m000) session. In the service
user profile, link the departments to the employee using the References menu -> Service Departments
by User Profile.

Note

The system uses the department, defined for the service user data and the departments of the linked
User Profile, to retrieve the service date from Infor LN to the workbench.

Map Provider Setting
You can select a map provider from the Map Providers (ttaad7132m000) session. A valid Bing map key
must be provided if the selected provider is Bing. In all the other cases, by default, the Open Street Map
is the default map.
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Note

Scheduler workbench requires an internet connection as Maps are used.

Adding Employee Picture
From Infor LN 10.4 onwards, a picture of the employee can also be added to the Employees – General
(tccom0101m000) session.

Note

The guidelines for pictures:
 ▪ The employee picture that is uploaded to the application must be have 500x500 dimension

at the least.

▪ The picture must be of portrait orientation; landscape pictures are displayed horizontally.

▪ Resolution must be 300 dpi and above. Lesser Dpi can scatter the image.

▪ The applicable extensions are .jpg, .gif, or .png.

Bing License key for Map
You can also use the COM Parameters (tccom5000m000) session to specify the Bing License Key. The
Bing license key is required to draw routes on the map. Also, the travel time durations are calculated
using Bing or Google. When a key is not inserted, the Open Street Maps are displayed.

The Bing license key is required to draw routes on the map. Also, the travel time durations are calculated
using Bing or Google.

When a key is not inserted; the Open Street Maps are displayed.

http setting for Open Street Map
This is applicable only for version 10.4 and below. To configure the ‘http’ (not https) connection, when
using Open Street Maps (not https):
 ▪ Open IIS Manager
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▪ In the Connections pane, expand the Sites node, and select the workbench site for which you
must add the http binding.

▪ In the Add Site Binding dialog box, specify the binding information (Type= http) and the new
port number of your choice and click OK.

▪ Start the Infor LN Workbench Web Server (ttaad7530m00) session, and specify the modified
Desk Web Server URL with the http as the binding and the new associated port number.
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The functional enhancements and Usability differences between versions 10.4 and below to the current
version (10.4.1 and above).

Difference Study
The functional enhancements and Usability differences between versions 10.4 and below to the current
version (10.4.1 and above).

Functional Differences
 1. The workbench is enhanced to display the Installation Group Views. The Installation Group

Views allows you to view, plan, or schedule service order activities and planned activities
against Installation Groups and Serials.

2. The Employee Based Planning, now, additionally displays the work orders along with service
order assignments. All the features of the workbench such as assigning, unassigning, defining
colors, performing multi activity planning, drill back operations can be performed on work
orders. The multi-activity planning can also be performed by selecting the service orders and
work orders.

3. The Activities grid is enhanced to display the new Assignment related columns such as
Assignment Status and Duration. The Assignment Status column displays the progress of the
assignment and the status.

Gantt
Update Indicators: Activity Update & Assignment Update.
 ▪ You can select update indicators based on their planning requirement.

▪ Activities are used to update the new times and duration to all the assignments belonging to
activity and the times and duration are also updated to the activity.

▪ Assignment are used to update the time and duration for specific assignments.
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▪ Whenever you modify these indicators, the application saves the data.

Location (Map)

Convex Hull

A new Convex Hull feature is included on the map to view the geographical area in which activities for
an engineer are spread. To use this feature, select an engineer from the map or Gantt and select the
'Show Convex' check box on the map toolbar. The Convex Hull for the selected engineer with the
assignments in the Gantt time range are displayed. As the Gantt time range changes, the convex hull
is redrawn considering the assignments available for the new time range.

User Interface Differences

Layout

 1. The main layout contains the Resources, Location, Activities, and Planned Activities sections.
The User Settings and Messages sections are not part of main layout.

2. The user settings can be viewed by selecting the User Settings option from the workbench
Settings menu.

3. The message pane is displayed in the workbench as a collapsible view which automatically
expanded when a message must be displayed. The message pane also displays the message
counts and the Clear option to delete the messages.

4. The workbench includes pre-defined layouts which can be selected from the 'Workspace'
menu on the toolbar. Click Save Defaults to save the selected layout in the User Settings. The
defaults are applied when the workbench is started again. The available layouts:
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a. Default View (Full Gantt on the right,
Map on top left, Activities and
Planned Activities on the bottom of
the page).

b. Full Gantt on Top.
c. Full Gantt on Top with Map Mini-

mized.
d. Full Map on Right.

Gantt

 1. On the Gantt, the Service Engineer display is enhanced to show the engineer's picture and
other details. You can select an engineer using the check box in the Engineer cell. Click Get
Current Location to update the current GPS location of the engineer on the map. Other
information such as Department and Calendar code can be viewed in the tooltip.

2. The Activity constraint rows are name Planned Timeline and Earliest Start – Latest Finish
Timeline respectively.

3. The conflict indicator is displayed in the activity bar on the Planned Timeline row. If the Show
Conflict Indicator on Activity Bar option is selected in the User settings then the conflict indicator
is displayed on all the assignments, if a conflict exists.

4. All the filter options are grouped in a drop-down-list-box. The filter options are Show All,
Selected Activity’s Context, Selected Order’s Context, Working Hour Type View, Show All
Overlapped Activities, and Show All Interrupted Activities.

5. All the timescale view options are grouped into a drop down menu. The timescale view options
are Day, Week and Month views.

6. The time scale navigation is grouped in a drop-down-list-box. The options are Today, Next
Day, and Next Week.

7. Previous  and Next  page. These options allow to move the Gantt timescale to the next
or previous page, based the current timescale settings.

8. Pan left  and Pan right . These options allow you to pan the Gantt timescale to the left
or right, based on the current timescale settings.

9. The legends for selected status, indicator symbols, and service types are displayed at the
bottom of the Gantt.

10. The mandatory skills in the Skills list on the Gantt toolbar and activities toolbar are marked
with an * (asterisk) in Red.
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Gantt Timescale zoom operations
 1. Using Ctrl + Scroll wheel up, to zoom to the Gantt time scale.

2. When a particular activity must always be visible in the displayed area, rest the pointer on that
activity and select CTRL + Scroll Wheel.

Activities and Planned Activities Grid
 1. The Activities and Planned Activity Grids has the option to hide/unhide columns. These grids

are enabled with the Paging option and the default page size is 50.

The  column is provided to enable the drag-and-drop option on the grid. When you left-click
the dotted image, the row is automatically selected.

2. The mandatory skills in the Skills list on the Gantt toolbar and activities toolbar are marked
with an * (asterisk) marked in Red.

Error Indicator Column
The messages (Error, Warning, and Informational) are displayed in the Messages pane.

User Settings

General tab

46 | Infor LN Service | User Guide for Service Scheduler Workbench

Difference Study



This section allows to select the views to be dis-
played in the workbench.

The Employee Based Planning section, allows you
to select the order types to be displayed and the
pattern for work orders in the workbench. The two
lists allow you to select the status for the service
order and the work order that are displayed in the
workbench.

The Installation Group Based Planning section, al-
lows you to select the status for the service order,
planned activity, and the planned activity pattern
displayed in the workbench.

Update Indicators:
 

This section allows you to select the Update Indi-
cator to be used when the workbench is loaded.

Gantt tab

Legends:

Select the Show Legends check box to list the leg-
ends on the Gantt.

Note: If Service Type color procedure is selected,
Service Type legends are also displayed in the
Gantt chart.

Others:
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The Show Picture check box is used to determine
if an Engineer’s image must be displayed.

The Show Conflict Indicator on Activity Bar check
box is used to determine if the conflict indicator
must be displayed on all the activities, if any con-
flicts exist.
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Colors tab

 
The Highlight Border allows to select the color of
the border for the selected Map pushpins.

Tooltip tab

 
This section allows you to select the attributes to
be displayed in the Work Order tooltip.

Indicator Symbols on Gantt

 
The Indicator symbols used to depict certain im-
portant attributes of the activity in Gantt chart are
changed as per the new UI guidelines.
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